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SUMMARY:  22 
Freshwater planarians exhibit three gaits (gliding, peristalsis, and scrunching) that are 23 
distinguishable by quantitative behavioral analysis. We describe a method to induce scrunching 24 
using various noxious stimuli, quantification thereof, and distinction from peristalsis and gliding. 25 
Using gene knockdown, we demonstrate the specificity of scrunching as a quantitative 26 
phenotypic readout. 27 
 28 
ABSTRACT:  29 
Freshwater planarians normally glide smoothly through ciliary propulsion on their ventral side. 30 
Certain environmental conditions, however, can induce musculature-driven forms of locomotion: 31 
peristalsis or scrunching. While peristalsis results from a ciliary defect, scrunching is independent 32 
of cilia function and is a specific response to certain stimuli, including amputation, noxious 33 
temperature, extreme pH, and ethanol. Thus, these two musculature-driven gaits are 34 
mechanistically distinct. However, they can be difficult to distinguish qualitatively. Here, we 35 
provide a protocol for inducing scrunching using various physical and chemical stimuli. We detail 36 
the quantitative characterization of scrunching, which can be used to distinguish it from 37 
peristalsis and gliding, using freely available software. Since scrunching is a universal planarian 38 
gait, albeit with characteristic species-specific differences, this protocol can be broadly applied 39 
to all species of planarians, when using appropriate considerations. To demonstrate this, we 40 
compare the response of the two most popular planarian species used in behavioral research, 41 
Dugesia japonica and Schmidtea mediterranea, to the same set of physical and chemical stimuli. 42 
Furthermore, the specificity of scrunching allows this protocol to be used in conjunction with 43 
RNA interference and/or pharmacological exposure to dissect the molecular targets and 44 
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neuronal circuits involved, potentially providing mechanistic insight into important aspects of 45 
nociception and neuromuscular communication. 46 
 47 
INTRODUCTION: 48 
In addition to their popularity for stem cell and regeneration research1–3, freshwater planarians 49 
have long been used in behavioral studies4,5, taking advantage of their comparatively large size 50 
(a few millimeters in length), ease and low cost of laboratory maintenance, and broad spectrum 51 
of observable behaviors. The introduction of computer vision and automated tracking to 52 
planarian behavior studies6–11 have enabled quantitative differentiation of behavioral 53 
phenotypes. Animal behavior is a direct readout of neuronal function. Because the planarian 54 
nervous system is of medium size and complexity, but shares conserved key elements with the 55 
vertebrate brain12–14, studying planarian behavior can provide insight into conserved 56 
mechanisms of neuronal action which may be hard to directly probe in more complex organisms. 57 
Thus, planarians are a valuable model for comparative neurobiology studies8,12,15–21. In addition, 58 
the aquatic environment allows for rapid and facile exposure to chemicals to study their effect 59 
on brain function in regenerating and adult planarians, making them a popular system for 60 
neurotoxicology22–26 .  61 
 62 
Planarians possess three distinct gaits, referred to as gliding, peristalsis, and scrunching. Each gait 63 
is exhibited under specific circumstances: gliding is the default gait, peristalsis occurs when ciliary 64 
function is compromised7,27, and scrunching is an escape gait – independent of cilia function – in 65 
response to certain noxious stimuli7. We have shown that scrunching is a specific response, 66 
elicited by the sensation of certain chemical or physical cues, including extreme temperatures or 67 
pH, mechanical injury, or specific chemical inducers, and thus is not a general stress 68 
response7,28,29. 69 
 70 
Because of its specificity and stereotypical parameters, which can easily be quantified using this 71 
protocol, scrunching is a powerful behavioral phenotype that enables researchers to perform 72 
mechanistic studies dissecting sensory pathways and neuronal control of behavior25,28. 73 
Additionally, scrunching has been shown to be a sensitive endpoint to assay adverse chemical 74 
effects on nervous system development and function in neurotoxicology studies22,24,25,30. As 75 
several different sensory pathways seem to converge to induce scrunching through various 76 
mechanisms28, scrunching differs from other planarian behaviors because various, but specific, 77 
stimuli can be used to dissect distinct neuronal circuits and study how different signals are 78 
integrated to produce the scrunching phenotype. 79 
 80 
Importantly, species differences exist, wherein one chemical may elicit scrunching in one 81 
planarian species, but a different behavioral response in another. For example, we have found 82 
that anandamide induces scrunching in the planarian species Dugesia japonica but induces 83 
peristalsis in Schmidtea mediterranea28. This example highlights the importance of being able to 84 
reliably distinguish between the different gaits, because they are the phenotypic manifestations 85 
of distinct molecular mechanisms. However, distinction of scrunching from peristalsis is difficult 86 
using qualitative observational data, because both gaits are musculature-driven and share 87 
qualitative similarities7,28. Thus, to distinguish the gaits it is necessary to perform cilia imaging or 88 



   

a quantitative behavioral study, which allows distinction based on characteristic parameters7,28. 89 
Because cilia imaging is experimentally challenging and requires specialized equipment such as a 90 
high-magnification compound microscope and a high-speed camera7,28, it is not as broadly 91 
accessible to researchers as quantitative behavioral analysis.  92 
 93 
Here, we present a protocol for (1) the induction of scrunching using various physical (noxious 94 
temperature, amputation, near-UV light) and chemical (allyl isothiocyanate (AITC), 95 
cinnamaldehyde) stimuli and (2) the quantitative analysis of planarian behavior using freely 96 
available software. By quantifying four parameters (frequency of body length oscillations, 97 
relative speed, maximum amplitude, and asymmetry of body elongation and contraction)7, 98 
scrunching can be differentiated from gliding, peristalsis, and other behavioral states reported in 99 
the literature, such as snake-like locomotion15 or epilepsies15. Furthermore, while scrunching is 100 
conserved among different planarian species7, each species has its own characteristic frequency 101 
and speed; therefore, once the gliding and scrunching speeds of a species have been determined, 102 
speed alone can be used as a means to distinguish scrunching from gliding and peristalsis29. The 103 
protocol assumes no prior training in computational image analysis or behavioral studies and 104 
thus can also be applied for planarian behavioral experiments in a teaching laboratory context at 105 
the undergraduate level. Example data to facilitate protocol adaptation is provided in the 106 
Supplemental Material. 107 
 108 
PROTOCOL: 109 
 110 
1. Quantitative planarian behavior assays 111 
 112 
1.1. Experimental setup 113 
 114 
1.1.1. Place a dimmable LED panel upon a flat surface. The LED panel serves two purposes: (1) 115 
to provide a uniform white background and (2) to be used as an adjustable light source to obtain 116 
appropriate contrast. Place a 100 mm Petri dish arena upon the LED panel. 117 
 118 
NOTE: To increase throughput, a multi-well plate may be used as an arena23,24, but larger arenas 119 
facilitate automated image analysis. 120 
 121 
1.1.2. Mount a camera on a ring stand above the arena (Figure 1A). Adjust the camera position, 122 
height, and focus as necessary so that the entire arena is centered within the field of view and is 123 
in focus (Figure 1B). 124 
 125 
NOTE: The camera resolution needs to be high enough to clearly distinguish a planarian from the 126 
homogenous background provided by the LED panel. 127 
 128 
1.1.3. Fill the arena with the appropriate exposure media (planarian water or chemical solution) 129 
to half-maximum volume (this will be referred to as a bath). This corresponds to approximately 130 
25 mL for a 100 mm Petri dish. Turn on the LED panel and turn off any other light sources that 131 



   

may negatively affect recording quality (i.e., nearby light sources that produce a glare onto the 132 
arena). 133 
 134 
CAUTION: Manage hazardous chemical solutions appropriately by wearing full personal 135 
protective equipment (PPE) and moving the experimental setup to a fume hood if necessary. 136 
Follow federal and state regulations on waste disposal. 137 
 138 
1.1.4. Drop a planarian toward the center of the arena using a transfer pipette. Begin recording. 139 
Record data as image sequences in a native Fiji31 format (TIFF, GIF, JPEG, PNG, DICOM, BMP, 140 
PGM, or FITS; see image analysis section 1.2).  141 
 142 
NOTE: Because behaviors and sensitivity to external stimuli vary among individual planarians, it 143 
is important to collect data on a sufficiently large number of biological replicates, in addition to 144 
performing technical replicates. We have worked with up to 10 medium-sized (4-7 mm) 145 
planarians in a 100 mm Petri dish at once. While time efficient, multiple planarians in the Petri 146 
dish at once make data analysis more difficult since planarians may cross paths. 147 
 148 
1.1.4.1. For gliding experiments, record using at least 1 frame per second (FPS). For 149 
scrunching/peristalsis experiments, record using an FPS that is at least twice the 150 
scrunching/peristalsis frequency of the planarian species. If the planarian species has an 151 
unknown scrunching/peristalsis frequency, use 10 FPS as a starting point and increase/decrease 152 
as appropriate. 153 
 154 
1.1.4.2. When using a chemical solution, transfer the planarian using as few drops of 155 
planarian water as possible so that the concentration of the chemical solution is not significantly 156 
changed.  157 
 158 
1.1.5. For gliding experiments, record 1-2 minutes of gliding behavior. For scrunching/peristalsis 159 
experiments, record long enough to capture at least 3 consecutive oscillations occurring in a 160 
straight line. Once the experiment is completed, terminate the recording.  161 
 162 
NOTE: For scrunching/peristalsis experiments, if a planarian does not satisfy the termination 163 
criterion within a fixed time period that needs to be consistent across replicates and is empirically 164 
determined based on the stimulus, terminate the recording and test another planarian.  165 
 166 
1.1.5.1. If the planarian reaches the boundary of the arena without satisfying the 167 
termination criterion, pipette the planarian back to the center of the arena. 168 
 169 
NOTE: Avoid repeated pipetting of an individual for recording, as this may change its behavior.  170 
 171 
1.1.6. Remove the planarian(s) from the arena and dispose of the planarian water or chemical 172 
solution in appropriate waste containers. Planarians that were in planarian water can be returned 173 
to their home container. 174 
 175 



   

NOTE: Avoid cross contamination by using different arenas for different media (i.e., gliding in 176 
planarian water experiments should not be run in an arena previously used for 177 
scrunching/peristalsis experiments with chemical exposure). 178 
 179 
1.1.6.1. Serially rinse planarians exposed to a chemical solution in 3 clean 100 mm Petri 180 
dishes filled with 25 mL of planarian water to thoroughly dilute out any chemicals. If scrunching 181 
or peristalsis was induced, place these planarians in a separate container. Planarians can be 182 
returned to their home container after one month since most cells would have turned over by 183 
that time1. 184 
 185 
NOTE: If multiple different experiments are needed for the same population of planarians, e.g., 186 
for an RNAi population, allow planarians to recover for 24 hours before running the next 187 
experiment. Order the experiments such that the least invasive experiment is first and the most 188 
invasive experiment (e.g., amputation) is run last. 189 
 190 
1.1.6.2. If running multiple experiments in the same arena, properly dispose of the bath 191 
solution and remove any mucus trails by wiping down the arena with a paper towel between 192 
runs.  193 
 194 
NOTE: The protocol can be paused here. 195 
 196 
1.2. Quantitative analysis of planarian behavior 197 
 198 
1.2.1. Perform planarian behavior assays as described in Section 1.1. 199 
 200 
1.2.2. Open the raw image sequence for an experiment in Fiji (File > Import > Image Sequence). 201 
Convert the image sequence to 8-bit (Image > Type > 8-bit) and use the arrow tool or slider at 202 
the bottom of the image stack to watch or pan through the image sequence. 203 
 204 
NOTE: For gliding experiments, all data can be used as long as the planarian can be clearly seen 205 
throughout the recording. However, it is usually sufficient to analyze the free motion in the center 206 
of the arena by extracting the relevant part(s) as described below.  207 
 208 
1.2.3. To extract a time period and region of interest, draw a region of interest encompassing 209 
the full path of a planarian using the rectangle tool (Figure 2A, 2B). Right click on the image stack 210 
and select Duplicate…, check the box for Duplicate stack, enter the first and last frames of the 211 
sequence of interest, and click OK. If multiple planarians were imaged simultaneously, repeat this 212 
region selection and duplication step for each planarian in the arena so that there are as many 213 
open image stacks as there are planarians in the arena. The following steps (Steps 1.2.4-1.2.10) 214 
should be performed on each image stack, one at a time. 215 
 216 
1.2.3.1. For gliding experiments, extract a period of gliding where the planarian moves at 217 
least twice its body length. 218 
 219 



   

NOTE: The more gliding data extracted per planarian, the more reliable the data will be. The 220 
planarian does not need to be moving in a straight line for the gliding analysis.  221 
 222 
1.2.3.2. For scrunching/peristalsis experiments, extract an instance when the planarian 223 
undergoes a minimum of three consecutive (ideally more) body oscillations in a straight line, 224 
making sure each oscillation is a complete elongation-contraction cycle, as full oscillations are 225 
necessary to accurately determine the frequency. 226 
 227 
NOTE: The more oscillations that can be extracted, the more reliable the data will be. Do not use 228 
sequences where the planarian is turning as these will result in inaccurate length measurements.  229 
  230 
1.2.4. Apply a threshold to the duplicated image stack (Image > Adjust > Threshold) to binarize 231 
the image and extract the planarian from the background. Adjust the sliding bars as necessary 232 
such that the entire planarian is highlighted in red. The exact values are dependent on imaging 233 
quality. Leave the boxes for Dark background, Stack histogram, and Don’t reset range 234 
unchecked. Scroll through the image stack to ensure a good threshold range (i.e., the planarian 235 
is well separated from the background throughout the stack), and then click Apply. 236 
 237 
1.2.5. In the Convert Stack to Binary window, set the Method to Default and the Background 238 
to Light. Uncheck all boxes in this window and then click OK. A binarized image showing a black 239 
planarian on a white background will appear (Figure 2C). Make sure that the entire planarian is 240 
visible in all frames of the image sequence. 241 
 242 
NOTE: Unwanted objects in the binarized image sequence that are smaller or larger than the 243 
planarian can be filtered out in the subsequent analysis using a size filter (Figure 2Ciii). 244 
 245 
1.2.6. Set measurements by clicking Analyze > Set Measurements. Check the boxes for Area, 246 
Center of mass, Stack position, and Fit ellipse and click OK. 247 
 248 
NOTE: These parameters only need to be set once per Fiji session. 249 
 250 
1.2.7. Select the open image stack and select Analyze > Analyze Particles.  251 
 252 
1.2.8. In the Analyze Particles window, select Show > Masks to open a new stack showing all 253 
the objects that were detected with the chosen parameters. This can be used to visually check 254 
that only measurements of the planarian are being taken. A size filter may be set at this step to 255 
remove unwanted noise by entering the approximate area of the planarian (in pixel2 units) in the 256 
space provided. Check the boxes for Display results and Clear results and click OK. 257 
 258 
NOTE: In the Results window, if the index (first column) does not equal the slice number for all 259 
rows, this means that either too many or too few objects were tracked. One possibility for this 260 
discrepancy is the presence of other objects besides the planarian or that the planarian was not 261 
tracked in specific frames.  262 
 263 



   

1.2.9. Pan through the mask image stack using the slider at the bottom of the panel. If there is 264 
any noise or there are frames that lack a planarian, close the Results window and the mask image 265 
stack. Repeat steps 1.2.7-1.2.8 by adjusting the area filter to only remove objects other than the 266 
planarian.  267 
 268 
NOTE: If the planarian is missing from the frame in the mask, this suggests that the lower bound 269 
of the area filter was set too high.  270 
 271 
1.2.10. On the Results window, save the data using File>Save As. Add the .csv extension to the 272 
filename to save data as comma-separated values. Once data for the image stack is saved, close 273 
the respective image stack, and Results and Mask windows.  274 
 275 
1.2.11. Import data and further analyze using any spreadsheet software or freeware. To calculate 276 
gliding speed, refer to section 1.3. To calculate the scrunching/peristalsis full parameter set, refer 277 
to section 1.4. 278 
 279 
NOTE: The protocol can be paused here. 280 
 281 
1.2.12. To determine the pixel to actual length conversion, open an image in Fiji with a reference 282 
length (e.g., the diameter of the arena). Select the line tool and draw a line over the known 283 
length. 284 
 285 
1.2.13. Convert pixel units to a standard unit of length by clicking Analyze > Set Scale. Enter the 286 
length corresponding to the line drawn on the image in the Known distance box and change Unit 287 
of length from pixel to the chosen standard unit of length. The conversion factor is written next 288 
to Scale. 289 
 290 
NOTE: A pixel conversion value is not required for gliding or scrunching/peristalsis analyses in 291 
sections 1.3 and 1.4. 292 
 293 
1.3. Calculation of gliding speed 294 
 295 
1.3.1. Using the data file saved in Section 1.2, load the center of mass (COM) x and y coordinates 296 
and the major axis data. If the data is saved as a comma-separated values file, these lists 297 
correspond to the “XM”, “YM”, and “Major” columns, respectively. 298 
 299 
1.3.2. Calculate the displacement (d) of the planarian center of mass in pixels for each frame 300 
with respect to the next frame using the “XM” and “YM” data columns. Displacement (d) is given 301 
by: 302 

𝑑 =  √(𝑥2 − 𝑥1)2 + (𝑦2 − 𝑦1)2  303 
where x1 and y1 refer to the COM coordinates (XM, YM) of one frame and x2 and y2 refer to the 304 
COM coordinates (XM, YM) of the subsequent frame. 305 
 306 



   

1.3.3. Set the planarian body length as the 95th percentile of the “Major” column. Since 307 
planarians exhibit a wall preference behavior32, this ensures that the calculated planarian body 308 
length is representative of when the planarian is elongated24. 309 
 310 
1.3.4. Normalize displacement by planarian body length by dividing the pixel displacements per 311 
frame by the planarian body length (l). Normalized displacement (dn) is given by: 312 

𝑑𝑛 =
𝑑

𝑙
 313 

 314 
1.3.5. Generate a list of normalized speeds by dividing the normalized displacements by the 315 
time elapsed per frame (inverse of the recorded FPS). Normalized gliding speed (sn) is given by: 316 

𝑠𝑛 =
𝑑𝑛

(𝐹𝑃𝑆)−1
 317 

 318 
1.3.6. Calculate the normalized gliding speed of the planarian by taking the average of the 319 
normalized speeds list (sn). The standard deviation may be used as an uncertainty measurement 320 
for the planarian. 321 
 322 
1.3.7. Repeat steps 1.3.1-1.3.6 for each planarian to be analyzed. Average and take the standard 323 
deviation of the gliding speeds for all planarians to get the gliding speed and associated 324 
uncertainty, respectively, for a planarian population.  325 
 326 
1.4. Distinction of scrunching and peristalsis gaits using the full parameter set 327 
 328 
1.4.1. Load the major axis data list from the data file saved from Section 1.2. If the data is saved 329 
as a comma-separated values file, this corresponds to the Major column. 330 
 331 
1.4.2. Create a list that numbers each data point in the Major column, starting with 0. Convert 332 
this list to time elapsed per frame by dividing by the recorded FPS.  333 
 334 
1.4.3. 1.4.3 Plot the Major column data with respect to time elapsed to generate a 335 
scrunching/peristalsis oscillation plot (Figure 3A). Using the oscillation plot, trim the data to at 336 
least three consecutive, straight-line oscillations (Figure 3Bi). Trim the data to start and end at 337 
local peaks (maximum elongation of oscillation) or troughs (minimum elongation of oscillation). 338 
 339 
NOTE: If local extrema are not approximately equal (peaks/troughs differ dramatically in heights), 340 
this suggests that the oscillations are not straight-line (Figure 3Bii). Extract another sequence of 341 
at least three consecutive, straight-line oscillations. Refer to Section 1.2. 342 
 343 
1.4.4. Confirm that the oscillation sequence of interest has been extracted and trimmed 344 
properly by replotting the trimmed Major data with respect to time. Use this trimmed data list 345 
for all subsequent calculations. 346 
 347 



   

1.4.5. To calculate oscillation frequency (νm), divide the number of oscillations (On) by the total 348 
number of data points in the trimmed major axis data list (N). Multiply FPS by this value to get 349 
frequency in oscillations per second. 350 

𝜈𝑚 = 𝐹𝑃𝑆 ∗ 
𝑂𝑛

𝑁
 351 

 352 
1.4.6. To calculate maximum elongation (|Δε|max), subtract the absolute minimum body length 353 
(lmin) from the absolute maximum body length (lmax). Normalize to elongated body length by 354 
dividing by the absolute maximum body length. 355 

|𝛥𝜀|𝑚𝑎𝑥 =
𝑙𝑚𝑎𝑥 − 𝑙𝑚𝑖𝑛

𝑙𝑚𝑎𝑥
 356 

 357 
1.4.7. To calculate speed per body length (v*

m), multiply the calculated maximum elongation by 358 
the oscillation frequency. 359 

𝜈𝑚
∗ = 𝜈𝑚 ∗  |𝛥𝜀|𝑚𝑎𝑥 360 

 361 
NOTE: Speed alone can be used to distinguish between scrunching and peristalsis gaits7. 362 
 363 
1.4.8. To calculate the fraction of time spent elongating (felong), take the derivative of the 364 
trimmed major axis data list with respect to time. Divide the number of positive data points (i.e., 365 
when the derivative is >0 (np), by the total number of data points in the major axis data list (nt)). 366 

𝑓𝑒𝑙𝑜𝑛𝑔 =
𝑛𝑝

𝑛𝑡
 367 

NOTE: Scrunching planarians exhibit an asymmetric fraction of time spent elongating whereas 368 
planarians performing peristalsis spend equal amounts of time elongating and contracting7.  369 
 370 
1.4.9. Repeat steps 1.4.1-1.4.8 for each planarian to be analyzed. Calculate a planarian 371 
population parameter set by taking the average and standard deviation of each parameter.  372 
 373 
NOTE: The parameter set can be used to determine if the oscillation behavior is scrunching, 374 
peristalsis or some other form of locomotion with periodic body shape changes. Both scrunching 375 
and peristalsis have fixed parameters for a given species7, with scrunching parameters generally 376 
being greater than peristalsis parameters7. While it is possible that one of the parameters may 377 
fall outside of the species-specific range, as we have previously observed with chemical 378 
induction28, the observed behavior must agree with at least 3 of 4 published parameters to be 379 
categorized as either peristalsis or scrunching.  380 
 381 
2. Scrunching induction 382 
 383 
2.1. Physical stimuli (noxious temperature, UV light, amputation) 384 
 385 
2.1.1. For all physical stimuli experiments, refer to Section 1.1 for the experimental setup. 386 
 387 



   

NOTE: It is best to use a large arena, such as a 100 mm Petri dish, for physical stimuli experiments 388 
to allow for more open space for maneuvering a pipette and/or razor blade. 389 
 390 
2.1.2. To induce scrunching via noxious temperature, heat planarian water in a glass beaker (at 391 
least 100 µL per planarian to be tested) to 65 °C on a hot plate.  392 
 393 
2.1.2.1. Place a planarian in the center of the arena. Wait until the planarian orients itself 394 
upright and begins gliding. Begin recording. 395 
 396 
2.1.2.2. Using a P-200 pipette, slowly pipette 100 µL of the 65 °C planarian water post-397 
pharyngeally onto the tail end of the planarian to induce scrunching. 398 
 399 
NOTE: Make sure the heated planarian water stays at 65°C. If necessary, reheat the water to 65°C 400 
prior to starting another experiment. Since pressure can also induce scrunching, slow pipetting 401 
is necessary. Pipetting room temperature water in the same way as in the experiment can serve 402 
as a control and practice option. 403 
 404 
2.1.2.3. Stop the recording once scrunching has ceased. Place the planarian in a recovery 405 
container and exchange the media in the petri dish with fresh, room temperature planarian water 406 
if running more experiments. 407 
 408 
2.1.3. To induce scrunching via amputation, transfer a planarian to the center of the arena and 409 
wait until the planarian orients itself upright and begins gliding. Begin recording. 410 
 411 
2.1.3.1. Amputate the planarian using a clean razor blade. Amputations may be done 412 
anywhere along the planarian as long as the cut location is consistent across experiments. 413 
 414 
NOTE: Scrunching parameters are extracted from the anterior piece. Thus, avoid obstructing the 415 
camera’s view of this part of the planarian when applying the cut by approaching from the 416 
posterior end. Plastic cover slips also work well for cutting and are a safer option, especially in a 417 
teaching setting. 418 
 419 
2.1.3.2. Stop the recording once the anterior piece has ceased scrunching. Remove both 420 
pieces, place them in a separate container and allow them to regenerate for 7 days. Amputated 421 
planarians can be reincorporated into the home container once regenerated. 422 
 423 
2.1.4. To induce scrunching using near-UV light, attach appropriate filters (e.g., Roscolux filters) 424 
to the camera lens to reduce the amount of reflected near-UV light that is collected by the camera 425 
and may interfere with imaging the planarian’s response. Instead of using the LED panel to 426 
illuminate the arena from below, use ambient red lighting to which planarians are insensitive33. 427 
 428 
2.1.4.1. Fill a 100 mm Petri dish arena with planarian water and place a single planarian 429 
(5-9 mm) in the center of the arena. Begin recording at 10 FPS.  430 
 431 



   

2.1.4.2. Hold a Class II UV laser pointer (405 ± 10 nm, output power <5 mW) approximately 432 
30 cm from the arena. Position the laser pointer at a 45° angle from the gliding planarian and 433 
then shine the laser pointer for 5-10 seconds halfway between the posterior end of the pharynx 434 
and the tail tip to induce scrunching.  435 
 436 
NOTE: The power of the laser pointer can be measured using a near-UV-sensitive power meter. 437 
 438 
2.1.4.3. Wait for the planarian to start gliding again before attempting two more 439 
stimulations on the same individual to test for reproducibility of the reaction. If the planarian 440 
keeps showing the same behavior, stop recording and put the planarian back in its container. If 441 
the behavior changes between stimulations, additional tests will show which response is the 442 
most prominent. 443 
 444 
NOTE: Planarians can become desensitized to near-UV light and will stop reacting. Consecutive 445 
stimulations require a rest period of 8-10 seconds.  446 
 447 
2.2. Chemical stimulus (AITC) 448 
 449 
2.2.1. To induce scrunching using a chemical, e.g., the TRPA1 agonist AITC28, planarians are 450 
ideally immersed in a bath of the chemical. If necessary, pipetting can be applied as described in 451 
section 2.1.2.3. 452 
 453 
CAUTION: AITC is flammable, acutely toxic, can cause skin and eye irritation, respiratory and skin 454 
sensitization, and is hazardous to aquatic life. AITC oil should be handled in a fume hood. Prior to 455 
making stock solutions of AITC, put on appropriate PPE (nitrile gloves and a lab coat) and set up 456 
appropriate solid and liquid hazardous waste disposal containers. 457 
 458 
2.2.2. In a fume hood, make a 10 mM stock solution of AITC in planarian water in a 50 mL 459 
centrifuge tube. This stock solution is useable for up to one month when stored at 4°C. 460 
 461 
2.2.2.1. From this stock, prepare a 25 mL working solution of 100 µM AITC in planarian 462 
water in a 50 mL centrifuge tube. This 100 µM AITC solution will be used to induce scrunching in 463 
planarians. 464 
 465 
NOTE: 100 µM AITC induces consistent scrunching in D. japonica and S. mediterranea 466 
planarians28. For other aquatic planarians, 100 µM can serve as a starting concentration and can 467 
be adjusted accordingly. 468 
 469 
2.2.2.2. Set up the experimental setup (refer to Section 1.1). Fill the arena with the AITC 470 
working solution and place it in a secondary container. The secondary container should hold at 471 
least twice the volume of the arena.  472 
 473 
NOTE: Experiments can be carried out inside a fume hood for extra safety. 474 
 475 



   

2.2.2.3. Transfer up to 10 planarians to the center of the arena and begin recording. 476 
 477 
2.2.2.4. Once the planarians become desensitized and cease scrunching, stop recording. 478 
Remove the planarians from the AITC solution and rinse (refer to Section 1.1). Dispose of solid 479 
and liquid AITC waste in appropriate waste containers. 480 
 481 
2.2.2.5. Verify the specificity of the response to AITC using RNAi to TRPA128 following 482 
standard protocols.  483 
 484 
REPRESENTATIVE RESULTS:  485 
Extraocular near-UV perception in S. mediterranea planarians is TRPA1-dependent and has been 486 
proposed to be linked to H2O2 release17. Because H2O2 exposure induces TRPA1-dependent 487 
scrunching in S. mediterranea and D. japonica planarians28, the steps in Section 2.1.4 can be used 488 
to test whether near-UV light exposure induces scrunching in both species. While D. japonica 489 
planarians scrunch (10/10) when exposed to near-UV light, S. mediterranea planarians either 490 
exhibit tail thinning (7/10) as previously described17 or no response (3/10) (Figure 4A,4B). A 491 
quantification of the scrunching parameters, as outlined in Section 1.4, for the D. japonica 492 
planarians that exhibited at least 3 consecutive straight-line scrunches reveals characteristic 493 
scrunching parameters for this species7,28 (𝜈𝑚 = 0.84 ± 0.14, |𝛥𝜀|𝑚𝑎𝑥 = 0.56 ± 0.06, 𝜈𝑚

∗  = 0.47 ± 494 
0.07, and 𝑓𝑒𝑙𝑜𝑛𝑔 = 0.56 ± 0.03, values reported as mean ± standard deviation for N=7).  495 

 496 
In contrast, exposure to 250 µM cinnamaldehyde, a known TRPA1 agonist in mice34, causes 497 
scrunching in S. mediterranea7,28 (𝜈𝑚 = 0.46 ± 0.08, |𝛥𝜀|𝑚𝑎𝑥 = 0.36 ± 0.08, 𝜈𝑚

∗  = 0.16 ± 0.04, and 498 
𝑓𝑒𝑙𝑜𝑛𝑔 = 0.58 ± 0.04, values reported as mean ± standard deviation for N=8) (Figure 5A), whereas 499 

D. japonica planarians at the same (and 1.6x the concentration) display a mixture of snake-like 500 
and oscillatory motion, interrupted by gliding and/or vigorous head turns (Figure 5A). A 501 
quantification of the (8/24) samples with at least three consecutive oscillations yields significantly 502 
lower values for 3 out of 4 parameters than expected for scrunching in this species (𝜈𝑚 = 0.43 ± 503 
0.08, |𝛥𝜀|𝑚𝑎𝑥  = 0.39 ± 0.03, 𝜈𝑚

∗  = 0.17 ± 0.02, and 𝑓𝑒𝑙𝑜𝑛𝑔 = 0.54 ± 0.06, values reported as mean 504 

± standard deviation for N=8). Thus, while D. japonica appear to scrunch upon cinnamaldehyde 505 
exposure, a comparison of the calculated parameters with the literature values for this species7,28 506 
shows that the observed oscillatory motion is not scrunching. This example highlights the 507 
importance of quantitative measurements in conjunction with careful inspection of the raw 508 
behavioral data to properly interpret observed behaviors.  509 
 510 
RNAi confirms the specificity of scrunching in response to cinnamaldehyde exposure in S. 511 
mediterranea. Within 180 seconds of exposure to 250 µM cinnamaldehyde in planarian water 512 
15/15 unc22 (control) RNAi S. mediterranea planarians scrunched, whereas 0/16 SmTRPA1 RNAi 513 
planarians scrunched (Figure 5B), demonstrating that S. mediterranea scrunching in 514 
cinnamaldehyde requires SmTRPA1. Knockdown of SmTRPA1 was confirmed through a 60 second 515 
exposure to a 100 μM AITC bath28.  516 
 517 
FIGURE AND TABLE LEGENDS:  518 
Figure 1. Planarian behavior experimental setup. (A) Sample experimental setup for studying 519 



   

planarian behavior. (B) 100 mm Petri dish arena centered in the field of view of the camera. 520 
 521 
Figure 2. Representative examples of the Fiji image analysis of planarians in arena. (A) Selected 522 
region of interest, encompassing the full planarian path, indicated by the yellow rectangle. (B) 523 
Sample frames from the region of interest after duplication. (C) Subtracting the planarian from 524 
background and noise via thresholding (i) 8-bit image of planarian with noise, denoted by the 525 
asterisk. (ii) Binarized image of planarian after thresholding. (iii) Mask of planarian after setting 526 
filtering by size to remove noise. 527 
 528 
Figure 3. Plotting planarian length with respect to time. (A) Raw plot of planarian length versus 529 
time for a scrunching S. mediterranea planarian. The asterisk denotes a moment when the 530 
planarian turned while scrunching. (B) Possible ways to trim scrunching data. (i) A correctly 531 
trimmed plot that removes the turning event data. (ii) An incorrectly trimmed plot that does not 532 
remove the turning event data. 533 
 534 
Figure 4. Species specific responses to near-UV light. (A) Sample frames of D. japonica 535 
scrunching and S. mediterranea tail thinning in response to near-UV light. (B) Representative 536 
oscillation plots of S. mediterranea and D. japonica in response to near-UV light. 537 
 538 
Figure 5. Species specific response to 250 μM cinnamaldehyde, a TRPA1 agonist. (A) 539 
Representative oscillation plots for D. japonica and S. mediterranea planarians in a 250 µM 540 
cinnamaldehyde bath. (B) Representative oscillation plots showing loss of scrunching in 250 µM 541 
cinnamaldehyde in SmTRPA1 RNAi S. mediterranea planarians. 542 
 543 
DISCUSSION: 544 
Using this protocol, one can quantitatively study the effects of physical and chemical stimuli7,28,29 545 
or genetic manipulation (RNAi)28,29 on planarian locomotion. To maximize spatial resolution, it is 546 
best to move the camera as close as possible to the arena while ensuring the entire arena is in 547 
the field of view. To increase throughput, the behavior of multiple planarians can be screened at 548 
once by recording multiple planarians simultaneously. When screening more than one planarian 549 
in a single arena, regions of interest can be drawn in Fiji to isolate individual planarians as 550 
described here or more advanced multi-object tracking can be employed. One issue with having 551 
multiple planarians in the same arena is that they can cross paths. This problem can be solved 552 
through the use of multi-well plates to isolate planarians from each other while still enabling 553 
simultaneous recording of many individuals to quantify behavior23,24. However, planarians will 554 
spend relatively more time at the wall in smaller arenas, requiring adjustments to the image 555 
analysis and limiting the resolution for scrunching/peristalsis quantification.  556 
 557 
When stimuli are administered locally (e.g., pipetting7, amputation7,28, laser pointer17), it is crucial 558 
that the planarians are consistently stimulated in the same region because stimulating other 559 
body regions can potentially induce different behaviors. Different methods of delivery (such as 560 
pipetting or bath of a chemical) can also affect the consistency of the behavioral phenotype. 561 
Additionally, planarians can desensitize quickly28, which needs to be taken into consideration 562 
when planning experiments as the same planarians should not be immediately reused for 563 



   

multiple experiments, either using the same or different stimuli. Finally, as shown here for near-564 
UV exposure and cinnamaldehyde, it is important to be aware that the same stimulus can induce 565 
distinct behaviors in different planarian species. D. japonica scrunched when stimulated with 566 
near-UV light near the tail tip, while S. mediterranea planarians displayed tail thinning. In 567 
contrast, cinnamaldehyde exposure induced scrunching in S. mediterranea but not in D. japonica 568 
planarians. Thus, while scrunching is a conserved response of various planarian species to 569 
noxious stimuli7, it has species specific parameters7,28, sensitivities28, and inducers28. Therefore, 570 
for a new species for which scrunching has not yet been parameterized, it is best to start with a 571 
well-conserved inducer, such as amputation7, to determine the species-specific parameters 572 
before testing the response to other stimuli. 573 
 574 
One limitation of the analysis described here is that it does not account for turns and/or mixed 575 
behaviors, such as intermittent scrunching with head wiggling, gliding, or other body shape 576 
changes. However, close inspection of the raw data can help mitigate these issues if these 577 
instances are manually excluded from the analysis, as demonstrated in Figure 3. In addition, it is 578 
possible to add body shape analysis to the center of mass and length tracking described here and 579 
expand the protocol to quantify these other planarian behaviors. Given that the analysis does 580 
not make any assumptions about the studied organism, the protocol could in principle also be 581 
applied to other organisms that show similar types of behaviors.  582 
 583 
The method of quantifying the different planarian gaits and distinguishing scrunching from 584 
peristalsis, as described here, assumes no prior training in computational image analysis or 585 
behavioral studies and does not require specialized equipment or software. To facilitate protocol 586 
adaptation, example data is provided in the Supplemental Material. The ease of obtaining and 587 
culturing planarians, as well as the ability to record behaviors without specialized equipment, 588 
makes planarian behavioral studies broadly accessible to research across all levels, from primary 589 
school classrooms to academic labs. A modified version of this protocol has been successfully 590 
used in a teaching laboratory setting that was primarily composed of freshmen and sophomore 591 
students and included both prospective STEM and non-STEM majors.  592 
 593 
The combination of molecular (RNAi) and chemical tools with quantitative behavioral analysis, as 594 
described in this protocol, allow researchers to gain mechanistic insights into the molecular 595 
control of behavior. Such work has uncovered some of the key mediators and neuronal circuits 596 
involved in planarian gliding19,20, phototaxis17,35,36, thermotaxis9,37, and scrunching9,28,29. Although 597 
planarian behaviors may not have direct corollary behaviors in higher organisms, such as humans, 598 
these behaviors represent fundamental neuronal functions important to all organisms - the 599 
ability to sense and process specific stimuli and react appropriately. Because of the conservation 600 
of key neuronal functions across different organisms, mechanistic studies in planarians can teach 601 
us more broadly about neuronal control of behavior. Additionally, analyzing planarian behavior 602 
in response to chemical exposure can be used to study the chemical’s effects on the planarian 603 
nervous system23–25, which may inform on potential risks to the human brain. In particular, 604 
scrunching induced by noxious heat was found to be a sensitive and specific endpoint for assaying 605 
neurotoxicity, because it becomes disrupted by exposure to certain classes of chemicals22,24,25,30. 606 
Finally, the planarian’s unique regenerative capabilities allow researchers to dissect the dynamics 607 



   

of how different behaviors are restored during neuroregeneration. 608 
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Name of Material/ Equipment Company Catalog Number
Allyl isothiocyanate, 95% (AITC) Sigma-Aldrich 377430-5G
Camera lens, 2/3 25mm F/1.4 Tamron 23FM25SP
Cell culture plates, 6 well, tissue culture treated Genesee Scientific 25-105
Centrifuge tubes, 50 mL polypropylene, sterile MedSupply Partners 62-1019-2
Cinnamaldehyde, >95% Sigma-Aldrich W228613-100G-K
Dimmable A4 LED Tracer Light Box Amazon B07HD631RP
Flea3 USB3 camera FLIR FL3-U3-13E4M
Heat resistant gloves Fisher Scientific 11-394-298
Hot plate Fisher Scientific HP88854200
Instant Ocean Sea Salt, prepared in deionized water Instant Ocean SS15-10

Montjüic salts, prepared in Milli-Q water Sigma-Aldrich various

Petri dishes, 100 mm x 20 mm, sterile polystyrene Simport D210-7
Pipette, 20-200 μL range Rainin 17008652
PYREX 150 mL beaker Sigma-Aldrich CLS1000150
Razor blade, 0.22 mm VWR 55411-050
Roscolux color filter:  Golden Amber Rosco R21
Roscolux color filter:  Medium Red Rosco R27
Roscolux color filter:  Storaro Red Rosco R2001
Samco transfer pipette, 62 µL large aperture Thermo Fisher 691TS

Support stand Fisher Scientific 12-947-976

Thermometer VWR 89095-600

UV laser pointer Amazon B082DGS86R
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Comments/Description
CAUTION:  Flammable and acutely toxic; handle in a fume hood with appropriate PPE.

Prepare in deionized water at 0.5 g/L.

Prepare in milli-Q water at 1.6 mM NaCl, 1.0 mM CaCl2, 1.0 mM MgSO4, 0.1 mM MgCl2, 0.1 mM KCl, 1.2 mM NaHCO3; adjust pH to 7.0 with HCl.

Alternatively purchase the Roscolux Designer Color Selector (Musson Theatrical product #SBLUX0306) which includes all 3 color filters together.

This is a Class II laser (405nm ±10nm) with output power <5 mW.



Prepare in milli-Q water at 1.6 mM NaCl, 1.0 mM CaCl2, 1.0 mM MgSO4, 0.1 mM MgCl2, 0.1 mM KCl, 1.2 mM NaHCO3; adjust pH to 7.0 with HCl.

Alternatively purchase the Roscolux Designer Color Selector (Musson Theatrical product #SBLUX0306) which includes all 3 color filters together.
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are highlighted in cyan for easy readability. In addition, we have provided example data sets of 

gliding, peristalsis, and scrunching. We have responded to all of the reviewers’ comments, 

detailed below.   

We trust that our revised manuscript is now suitable for publication, and, on behalf of my co-

authors, thank you for the expedited review.   

Sincerely,  

Eva-Maria S. Collins 

 

Response to Reviewers: 

Editorial comments: 

Changes to be made by the Author(s): 

1. Please take this opportunity to thoroughly proofread the manuscript to ensure that there are no 

spelling or grammar issues. The JoVE editor will not copy-edit your manuscript and any errors in 

the submitted revision may  

Response: We have thoroughly proofread the manuscript. 

 

Reviewers' comments: 

Reviewer #1: 

Manuscript Summary: 

This is a well-written and clearly presented protocol for conducting a quantitative behavioral 

readout of noxious stimuli sensing in planaria via quantification of scrunching behavior. The 

authors utilize a straightforward computational image analysis to differentiate scrunching from 

peristalsis and enable differentiation of behaviors among species and across experimental 

conditions. 
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Major Concerns: 

None 

 

Minor Concerns: 

The authors mention that this experimental protocol is appropriate for a teaching laboratory 

course at the undergraduate level. It would be beneficial to students and instructors in those 

courses, as well as the research community at large, to provide an example dataset that can be 

processed alongside the video presentation. In my opinion, this would considerably strengthen 

the adoptability and utility of the methodology described, and bring the protocol presented in line 

with the author's claim that it requires no prior training in computational image analysis or 

behavioral studies. 

Response: We thank the referee for pointing this out and have now included sample data as 

supplemental material as suggested.  

 

Reviewer #2: 

Manuscript Summary: 

The manuscript by Collins and her coworkers provides the tools and methods for developing a 

system to track planarian "scrunching", locomotory behavior associated with noxious stimuli. 

The gear and techniques involved to put this system together are readily accessible without the 

need for great expense or training. Planarians themselves are a very useful model system that can 

be manipulated via genetic and pharmacological techniques to understand basic neurobehavioral 

principles. Together, this visual recording technique for Planarians can be used for a variety of 

research and educational purposes including species-specific changes in locomotion and 

responses to nociceptive stimuli. In fact, this group has already used this approach in one peer-

reviewed study about Planarian responses to noxious stimuli. 

 

Major Concerns: 

This is a very well-written submission and I have no major or minor concerns. 

Response: We thank the reviewer for their positive comments. 

 

 



Reviewer #3: 

Manuscript Summary: 

Sabry et al. present a new and quantitative protocol analyzing the locomotion of the freshwater 

planarian. This manuscript focuses on three gaits of movement that are distinguishable through 

video and quantitative analysis. The authors propose a new protocol for the induction of 

scrunching using various physical and chemical stimuli as well as the quantitative analysis of 

planarian behavior to these stimuli as an alternative to the difficulties of cilia imaging. Overall, 

this review is concise and well written. However, to enhance the strength of the paper, some 

points require clarification and further analysis. The authors may want to consider the aspects 

described below: 

 

Major Concerns: 

1. The paper is clear and easy to follow. However, the authors may expand on the justification of 

the protocol. In the current version, the need for the protocol is not readily evident. The text in 

the introduction may be the right location for placing the need in context. 

Response: We have expanded the Introduction to more clearly convey the broader context 

and applicability of this protocol.  

2. The discussion could be enhanced by placing the opportunity of measuring scrunching in 

planarians in the context of the field. Currently, the discussion is more focused on the 

troubleshooting of the protocol. Thus, incorporating comments that broadly represent the 

advantage of this protocol and how this could help to illuminate some areas that are difficult in 

other model organisms or phenotypes may prove beneficial for the field in general. 

Response: In the original manuscript, the Discussion was focused on the technical aspects 

of the protocol, per JoVE guidelines. Following the reviewer’s advice, we have expanded 

the new Discussion to provide broader context of the applicability and benefits of studying 

planarian scrunching using our protocol, including the unique advantages provided by the 

planarian system.  

3. In 1.1.5.1 the authors mention, "If a planarian reaches the boundary of the arena without 

satisfying the termination criterion, pipette the planaria back to the center of the arena." 

However, this may cause inaccurate data as some planaria will be exposed to the 

scrunching/peristalsis chemical solution for a more extended period than others if they are used 

for repeated experiments. As stated in 1.1.5, a standard experiment "Consists of completing 1-2 

minutes of gliding behavior or recording long enough to capture at least three consecutive 

oscillations occurring in a straight line." The recommendation for the author is to clarify, is if 

they are implying on reusing a Planaria or set of Planaria until they get their expected result? 



Response: An additional NOTE has been added to clarify this point. While the duration of 

gliding experiments without chemical stimulus is less important as long as sufficient data is 

generated, it is important to keep the duration of chemical exposure constant, as pointed 

out by the referee. The newly added NOTE makes this distinction clear. Planarians should 

not be reused in the same experiment when exposed to a stimulant; however, they can be 

and often should be reused for first taking gliding data and then exposing them to a 

stimulant, to have a record of the baseline behavior.  

 



README 

For each planarian gait (gliding, scrunching, and peristalsis), a folder containing a sample dataset is 

included. Each dataset contains an .avi movie of the respective behavior, which can be opened and 

converted to 8-bit in Fiji in the same manner as a file sequence, as described in Step 1.2.2 in the protocol. 

All .avi files were recorded at 10 FPS. As these data have already been pre-processed to extract an 

appropriate behavioral sequence for one planarian, the reader should start at Protocol Step 1.2.4 to 

continue with the analysis. The reader can check their analysis by comparing to the provided .csv files 

containing the tracking data and the .png oscillation plot for scrunching and peristalsis. Parameters for 

the three sample gaits are provided in the data table below. 

The provided data are of Schmidtea mediterranea planarians. The various gaits were induced by the 

following conditions: 

Gliding: SmTRPA RNAi planarians in 40 mM H2O2 

Peristalsis: Wild-type planarians in 100 µM anandamide 

Scrunching: Wild-type planarians in 100 µM AITC 

 

Gait Frequency (cycles s -1) Maximum 

elongation 

Speed 

(body length s-1) 

Fraction of time 

spent elongating 

Gliding -- -- 0.21 -- 

Peristalsis 0.25 0.29 0.07 0.50 

Scrunching 0.42 0.45 0.19 0.55 
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